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1 Product Introduction

1.1 Product Feature

DWIN Linux screen(36 series), with CAN interface.

CPU：Allwinner T113-S3, Quad-core ARM Cortex-A7

RAM: 128MB DDR3

Storage: 8GB EMMC

Main Frequency: 1GHz

Linux Version: Linux 5.4

DMT10600T101_36WTC
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DMT10600T101_36WTC

1.1.2 Development Method

QT and LVGL are optional.

The development materials and tools can be referred to:

Documents: https://www.dwin-global.com/development-guide/

Tool: https://www.dwin-global.com/tool-page/

1.1.3 Shipping List(for reference)

• screen ×1

1.1.4 Optional Accessories

• SD card

https://www.dwin-global.com/tool-page/
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1.2 Wiring

Regarding the definition of serial please refer to the related datasheet as below:

Datasheet_Peripheral and Interfaces

Datasheet_Interface Definition
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1.2.1 Hardware Connection

GND, Ground, connect to GND pin of the user device.

TXD, Transmit, connect to RX pin of the user device.

RXD, Receive, connect to TX pin of the user device.

Wiring Schematic Diagram with a DB9 Interface

1.2.2 Serial Parameter Setting

All the defined serial port baud rates are 115200. In general, the default serial port for debugging is

Serial Port 0.

1.2.3 Other Tools

DC regulated 12V power supply is recommended for testing, using SD card with 1~16 GB memory

for project downloading.
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2 Environment Configuration

2.1 Ubuntu16.04 Configuration

2.1.1 Introduction

This section provides a tutorial on installing a virtual machine and configuring Ubuntu 16.04 on it. If

already have Ubuntu 16.04 installed, you can skip this section and refer to Section 1.2 for toolchain

installation and configuration.

2.1.2 Environment Requirements

CPU: No specific requirements.

Memory: Generally, 2GB or more.

Host Operating System: Windows XP, Windows 7, and above.

Version Selection: Depending on your needs (Windows version), choose VMware Workstation 10

and above. Versions below 10 are not recommended.

Note: This example demonstrates the installation using VMware Workstation 15 Pro. If you

have already installed the virtual machine and Ubuntu, you can proceed directly to Section 1.2 for

toolchain installation.
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2.1.3 VMware Workstation Installation

(1) Running installation package

(2) In the End User License Agreement interface, select the checkbox "I accept the terms in the license

agreement", and then click "Next".
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(3) Select the installation path (or choose default path), check the "Enhanced keyboard driver" option

and click "Next".

(4) Appropriately select the checkboxes of "Check for product updates on startup" and "Help improve

VMware Workstation Pro" according to your own situation, and then click "Next".
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(5) Select the checkboxes for "Desktop" and "Start Menu Programs Folder", and then click "Next".

(6) Click "install".

(7) After a period of time, the installation will be completed. Click "Finish".

2.1.4 Download Ubuntu

(1) Ubuntu16.04 from official website: https://releases.ubuntu.com/16.04/

(2) Choose and download 64-bit PC desktop image "ubuntu-16.04.7-desktop-amd64.iso".

2.1.5 Ubuntu Installation

(1) Open VMware Workstation.

(2) Create a new virtual machine.

https://releases.ubuntu.com/16.04/
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(3) Select "custom (advanced)" and click "Next".
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(4) Choose "Installer disc image file (iso)" – "Browse"– select the download file ***.iso containing

Ubuntu, it will automatically recognize and read the file, then click "Next".

(5) Input custom name and password, the password will serve as the login password for Ubuntu and

the sudo authorization password, then click "Next".
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(6) Setup the name of Ubuntu and location, click "Next".

(7) Based on user’s requirements and computer configuration, allocate the number of processors and

cores(Here, the author sets the total number of processor cores to 2). Click "Next".
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(8) The default allocated memory is 2GB (sufficient, can be changed later). Click "Next".

(9) The default configuration is fine (however, in the network type section here, you can choose the

bridged network, which can be used for tftp transmission). Click "Next" until you reach the "Select a Disk"

step.



DWIN Technology Co., Ltd. Professional Creditable Successful

13

(10) Select "Create a new virtual disk", and click "Next".

(11) Set the disk capacity: It is recommended to set the disk capacity according to the size of the

computer's memory. When the memory is large, it can be set to more than 30GB. If you need to increase the

disk space, please refer to the subsequent chapters for expansion. Click "Next" to continue.

(12) The disk will be automatically named, keep the default and click "Next".

(13) After clicking "Finish", the virtual machine will start, and the installation will begin.

(14) Please wait patiently for a while.
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(15) When this interface appears, it indicates that the installation of Ubuntu is complete. (Note: For the

two user login inputs on the login interface, the content within the red frame is user-defined, and the content

within the green frame is provided by the system.)

(16) Next, we will start to configure the required environment for Ubuntu.

2.1.6 Setting up the Shared Folder

(1) Shut down Ubuntu. Click "Shut Down" in the upper right corner of the desktop.
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(2) After shutting down, on the corresponding virtual machine page, click "Edit virtual machine

settings"→"Options"→"Shared Folders"→"Always enabled"→"Add". Add a folder as a medium for

transferring files between the host machine and the virtual machine. Finally, click "OK".

(3) When starting up the virtual machine, click "Virtual Machine"→ "Install VMware Tools". (Note:

You can only select "Install VMware Tools" when the virtual machine is starting up. Otherwise, this option

will be grayed out and unavailable. Since the author has already installed VMware Tools, it will display

"Reinstall VMware Tools" instead.)
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(4) Click "DVD" icon and open to see a compressed file "VMwareTools-10.3.10-12406962.tar.gz".

(5) Right-click and choose "Copy to" to a path with permissions, you can directly copy it to "home."

(6) At this point, open the terminal by pressing [Ctrl] + [Alt] + [T], which will open the terminal in the

root directory

(7) Enter the command to add executable permissions: sudo chmod +x VM (use the Tab key to

display the full name) (Enter) (Note: When using sudo privileges for the first time, you need to enter the

password, and it won't be visible when entering the password).
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(8) Enter the decompression command: tar -xvf VM (Tab key) (Enter), and it will automatically

decompress to generate "vmware-tools-distrib" in the current directory. Enter the command: cd vm (Tab key)

(Press the Enter key. The subsequent steps will be omitted and not written).

(9) Enter the run command: sudo ./vm (Tab), and the installation will begin. When [yes] or [no]

appears, just enter "y" and press Enter key (the default for enabling shared folders is no, for ease of

operation, all configurations are selected with "y"). Press Enter key for the remaining cases until it shows as

shown in the image, indicating that the installation is complete.

(10) Enter the command: cd /mnt (Keep pressing the Tab key until you reach the shared folder you

have set up.), the path is /mnt/hfgs/***. The shared folder is now set up, and you can proceed to install the

T113 toolchain on Ubuntu.

2.2 Installing the T113 Toolchain

(1) Move the T113 compressed package (buildroot-T113-QT5_12_5-sdk-soft20221012.tar.gz) to

Ubuntu, you can use a shared folder or transfer via SFTP, etc.
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(2) Move the file to the root directory (/home/dwin). When using a shared folder, enter the command:

sudo mv buil (Tab)~, after waiting for a while, it moves to the root directory.

(3) Enter the command: tar -xvf bu(TAB) to unzip the file.

(4) Enter the following commands one by one:

cd bui(TAB)

source env-setup.sh

Then, enter "qmake -v" to check the version information of qmake and check if the setup is successful.

2.3 Screen Configuration

2.3.1 Hardware Introduction

Please refer to the related datasheet.

2.3.2 Terminal Software

SecureCRT or MobaXterm are optional, we will introduce MobaXterm in this section.

Two types of connection: serial or Telnet.

2.3.3 Serial communication

(1) Connect to Serial 2 (RX2/TX2), RS232 connection in this example.
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Connect 2(RX) to TX2, 3(TX) to RX2, and 5 to GND.

(2) MobaXterm Configuration: Sessions→New session→Choose ‘serial’→Choose the serial port, set the

baud rate in the third step, and cross-check the information→click ‘OK’ to complete.



DWIN Technology Co., Ltd. Professional Creditable Successful

20

(3) At this time, power on the screen, and enter the username "root" and the password "Dwin123", then

you can start the operation.

2.3.4 Telnet Connection via Ethernet

Note: Please ensure that the computer and the device are in the same network segment (the default IP

address of the screen device is 192.168.10.202). Otherwise, please use a network cable to connect the

computer to the device, set the computer's IP address as a static IP 192.168.10.xxx (xxx is not 202) and try to

connect to the device. After a successful connection, if the device needs to be connected to the local area

network, please refer to Chapter 2.3.5 to modify the device's IP address by yourself, and then use two

network cables to connect the device and the computer respectively. The following operations assume that

the device and the computer are in the same network segment. In the example, the computer's IP address is

192.168.10.14 and the device's IP address is 192.168.10.202.
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(1) Insert the network cable into the network ports of both the computer and the screen.

(2) As shown in the figure, in the first step, click "Sessions" and select "New session". In the second

step, select "Telnet". In the third step, enter the IP address of the screen and click "OK". (Note: The default

IP address of the screen is 192.168.10.202, and communication can only be achieved when connected within

the same local area network.)

(3) At this time, power on the screen. The following interface will be displayed. Enter the account

"root" and the password "Dwin123", and then you can start the operation. (The password input on the device

side is not visible.)
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2.3.5 Screen IP Configuration

If you need to modify the IP address, after connecting to the device as described in the previous section,

you can enter: vi /etc/init.d/S40 (TAB). Move the cursor to the "ifconfig" line and press the "i" key to start

editing. After modifying the IP address, press the "Esc" key, then enter: (colon) wq (press the Enter key),

which means saving the changes and exiting, and thus the modification of the IP address is completed.

2.3.6 Application Upgrade Guide

2.3.6.1 Principle of the Application Upgrade Package

(1) In the running environment of the standard screen, there exists a file named /etc/emcversion, in

which the current version number is stored.

(2) Only when the file name of the upgrade package is consistent with the version number can the

upgrade be carried out. Generally, the version number should be modified in the upgrade file to avoid

repeated upgrades.

(3) The naming rule of the upgrade package is "version number.tar". The initial version number of the

36 series is: A01-1-0.

(4) During the power-on startup process of the standard screen, it will actively detect the USB flash

drive and search for the "update" subdirectory in its root directory. If there is an upgrade package, it will
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automatically unzip it and execute the "install.sh" script in the upgrade package.

(5) After the "install.sh" script gains control, it can copy files, modify file attributes, and complete the

upgrade function.

2.3.6.2 Application Upgrade Package Production

(1) In the Ubuntu environment, centrally store the files to be upgraded in a unified directory.

(2) Add an install.sh file into the directory, modifying the script for file copying and attribute changes.

(3) In the Ubuntu environment, pack this directory using the command: tar -cvf DWIN_V1.X.X.tar

<INSTALL>

(4) Copy the file (e.g., DWIN_V1.X.X.tar) to the USBflash drive /update directory.

2.3.6.3 Usage of the Application Upgrade Package

(1) The standard program is burned into the standard screen, and the screen can be normally lit up.

(2) According to the needs, a specific application upgrade package can be selected, and this package

should be copied to the /update directory of the USB flash drive.

(3) Before powering on, insert the USB flash drive into the standard screen.

(4) After powering on, wait for the standard screen to automatically shut down, which indicates that the

upgrade is successful.

2.3.6.4 Example of Upgrade Package (Modifying the Boot-up Running Program)

The composition of the folder before compression and packaging is as follows:

emcversion file stores the updated version number for device updates.

myapp folder contains files to be upgraded.

etc folder stores scripts in /etc/init.d/ that may need to be modified (it can be excluded if there are none).

The example files of Install.sh is as follows:
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#!/bin/sh

copy_dir()

{

if [ -d $1 ]; then

for libfile in $1/*; do

if [ -f $libfile ]; then

cp $libfile $2/

chmod $3 $2/${libfile##*/}

#echo $2/${libfile##*/}

fi

done

fi

}

instdir=$(cd `dirname $0`; pwd)

# update the emcversion

cp $instdir/emcversion /etc/

# copy application file

cp $instdir/myapp/myapp /usr/local/bin/myapp

# modify permission

chmod 755 /usr/local/bin/myapp

# modify runqt script file if needed

cp -a $instdir/etc/init.d/* /etc/init.d/

2.3.6.5 Example of Upgrade Package (Modifying the Boot-up LOGO)

(1) The composition of the A01-1-0.tar folder before compression and packaging is as follows:

emcversion file stores the updated version number for device updates.

The replacement logo pictures are stored in the "logo" folder. The picture must be named
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"bootlogo.bmp", and the logo file must be a 24-bit BMP format image. Meanwhile, the location where

the logo picture should be placed is: logoupdate/logo/bootlogo.bmp.

.

Example install.sh file:

#!/bin/sh

copy_dir()

{

if [ -d $1 ]; then

for libfile in $1/*; do

if [ -f $libfile ]; then

cp $libfile $2/

chmod $3 $2/${libfile##*/}

#echo $2/${libfile##*/}

fi

done

fi

}

instdir=$(cd `dirname $0`; pwd)

# update the emcversion

cp $instdir/emcversion /etc/

# copy logo file

if [ -f $instdir/logo/bootlogo.bmp ]; then

mkdir -p /extp/temp0p2

mount /dev/mmcblk0p2 /extp/temp0p2

cp -a $instdir/logo/bootlogo.bmp /extp/temp0p2/

umount /extp/temp0p2
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rm -r /extp/temp0p2

sync

fi

sync

$instdir/serio_app

(2) Compress the "logoupdate" directory into a tar file and name it "A01-1-0.tar". Copy this tar file to

the "update" directory of the USB drive. Then, power off the device, insert the USB drive, and power it on

again. Once the upgrade is successful, you will hear a "beep" sound. After that, the screen will turn off. Then,

remove the USB drive, power off the device and restart it, and check whether the boot logo is correct.

(3) Precautions:

1. After testing, when unzipped in the Windows environment, only replace the "bootlogo.bmp"

file, and then repackage it. The update can be successful in this way. If the upgrade fails, it may be due

to the lack of execution permission. Please go to the Linux environment to confirm whether the

"install.sh" file has the execution permission.

2. The command to compress a tar file in Linux: tar -cvf A01-1-0.tar logoupdate

3. Don't put too many files in the USB drive (it is recommended to use a dedicated USB drive that

only contains the upgrade file). Otherwise, it may cause the update to fail.

4. This upgrade package can be obtained from the sales staff.
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3 Cross-Compilation of QT Project Files

3.1 Configuration of Cross-Compilation of Qt Creator

3.1.1 System Requirements

This document has been verified based on the Ubuntu 14.04 system, and other versions of the Ubuntu

system have not been verified.

3.1.2 Download the Installation Package of Qt Creator

The version of QtCreator used in this document is 2.7.2. Please download the version that is compatible

with your operating system.

3.1.3 Install Qt Creator

Copy the installation package to the Ubuntu system and grant the file execution permission:

# chmod +x qt-creator-linux-x86_64-opensource-2.7.2.bin

3.1.4 Run the Installation Package

# sudo

./qt-creator-linux-x86_64-opensource-2.7.2

.bin

Just click "Next" directly.
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3.1.5 Configure the Cross-compilation Environment

3.1.5.1 Run the QtCreator

The executable program of QtCreator is located in the "bin" directory under the installation directory:

# /opt/qtcreator-2.7.2a/bin/qtcreator

The software interface is as follows:
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3.1.5.2 Configure the Cross-Compilation Environment

Select the "Tools"→Option

Set qmake: Select "Build & Run"→"Qt Version"→"Add":

Qmake is located in the directory sysroot/usr/local/Qt_5.12.5/bin/ of the buildroot - T113 - QT5_12_5 -

sdk - soft20221012.tar.gz package.
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Set the compilation toolchain: Select "Build & Run"→"Compiler"→"Add"
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The compiler is located in the directory gcc-linaro-7.3.1-2018.05-x86_64_arm-linux-gnueabi/bin of

the buildroot-T113-QT5_12_5-sdk-soft20221012.tar.gz package.
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Set up the build kit: Select "Build & Run"→"Build Kit".

3.1.6 Compile Qt Project

3.1.6.1 Open the Project

File→Open the file or project:
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Select the Qt project you want to open:

Configure the project:

3.1.6.2 Add Environment Variables

Project→Build & Run→Build Environment, add a variable value. Variable name: T113_SYSROOT
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The value of the variable:

The "sysroot" directory of the "buildroot-T113-QT5_12_5-sdk-soft20221012.tar.gz" package.

3.1.6.3 Execute qmake

Select the project, right-click→Execute qmake
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When qmake is successful, it is as shown in the following figure (the red part is the printout of

DWIN_QT_DEMO.pri and does not affect the result):

3.1.6.4 Build

Edit→Select the project, right-click→Build
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Build completed

Up to this point, the target file has been generated in the project directory, and it can be copied to the

screen for running.
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3.2 qmake

(1) After entering the environment that has been configured in Section 2.2 of Chapter 2 (that is, after

running the source env-setup.sh command), you can use the qmake -v command to verify whether the

environment is correct. Open the project folder that needs cross-compilation (here, the provided

DWIN_QT_DEMO is selected, and put the folder into the /home/dwin/ directory of Ubuntu). Then, enter the

instruction: qmake (if the .pro file has not been generated yet, you need to run qmake -project first). This

will generate the Makefile file.

(2) Enter the command: make. Subsequently, a binary file named as a project will be generated.

However, this file cannot be executed in Ubuntu and needs to be downloaded to the screen.
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3.3 Download via USB Flash Drive

(1) Put the compiled file under the shared folder. You can copy the file using the command: cp (file

name) (shared folder path). For example: cp dwinqtdemo /mnt/hgfs/share/

(2) Move the target file in the shared folder from the computer's files to the USB flash drive.

(3) Insert the USB flash drive into the screen.

(4) Open MobaXterm and establish a connection. Then, enter the command: cd /mnt/usb to enter the

"usb" folder. Select the "sdax" folder and copy or move the target file to the target directory (you can

customize the folder at will to avoid clutter caused by too many files later). Use the command: cp (target file)

(folder). For example: cp dwinqtdemo /usr/bin/.

3.4 Run dwinqtdemo

To run the above-mentioned program, need to modify the configuration file /etc/init.d/runqt.

Enter: vi /etc/init.d/runqt.

Move the cursor to the beginning of the qttesttool line, press i to enter the input mode, type # to

comment out the line. Move the cursor to the end of the line, press Enter key to go to the next line, then

enter the absolute path of the dwinqtdemo program + space + &. Press Esc to exit input mode, and enter:

(colon)wq to save the file modifications.
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Then the program can be ran by runqt.

If the initial setting is not to run the runqt program by default, you can modify it in the /etc/init.d/rcS

file. If you want to set runqt to start automatically when the system boots up, set the last three lines of

/etc/init.d/rcS to the following code:
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After saving, enter the "reboot" command and then restart the screen.

3.5 Network Function

3.5.1 Network Configuration

Here, it is recommended to use a serial port to connect to the device for configuration.

(1) After connecting the network cable, configure the gateway: route add default gw Gateway IP (in

my case, it is 192.168.10.1).

(2) Configure the DNS. Use the command: vi /etc/resolv.conf. Press the "i" key to enter the input

mode, and then enter: nameserver 8.8.4.4. After that, press the ESC key, enter: (colon)wq, save and exit.

(3) Try to ping an external network address and check the result.

(4) If you need to permanently modify the gateway and DNS, you can add the following statements

after "ifconfig eth0 IP address" in the /etc/init.d/S40network file: route add default gw Gateway address;

echo "nameserver 8.8.4.4" >> /etc/resolv.conf". After the modification, it is as shown in the following figure.
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3.6 System Time Setting

Command format:

5A A5 08 02 Year-2000 Month-1 Day Hour Minute Second checksum

C++ example：

void BasicTester::SetTime(const QDateTime& time)

{

if (!time.isValid())

return;

unsigned char cmd[11] = {0};

cmd[0] = 0x5A;

cmd[1] = 0xA5;

cmd[2] = 0x08;

cmd[3] = 0x02;

cmd[4] = time.date().year() - 2000;

cmd[5] = time.date().month() - 1;

cmd[6] = time.date().day();

cmd[7] = time.time().hour();

cmd[8] = time.time().minute();

cmd[9] = time.time().second();

unsigned char checksum = 0;

for (int i = 2; i < 10; i++)

checksum += cmd[i];

cmd[10] = checksum;

// set time to tps02

int fd = open(DWIN_TPS02_UART, O_RDWR|O_NONBLOCK|O_NOCTTY);

if (fd < 0)

return;

::write(fd, cmd, 11);

::close(fd);
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struct tm t;

t.tm_year = time.date().year() - 1900;

t.tm_mon = time.date().month() - 1;

t.tm_mday = time.date().day();

t.tm_hour = time.time().hour();

t.tm_min = time.time().minute();

t.tm_sec = time.time().second();

struct timeval tv;

tv.tv_sec = mktime(&t);

tv.tv_usec = 0;

settimeofday(&tv,NULL);

}

3.7 Brightness Adjustment

Adjust brightness by sending message from internal serial port, the internal serial of 36 series is

/dev/ttyS1.

CMD=0x04, DATA=Diming_Set(0x00-0x64), Byte5 is checksum.

5A A5 03 04 0×00-0×64 checksum

Use command echo to test:

Off (set brightness is 0x00): echo -e -n "\x5A\xA5\x03\x04\x00\x07" > /dev/ttyS1

On (set brightness is 0x60): echo -e -n "\x5A\xA5\x03\x04\x60\x67" > /dev/ttyS1

C++ example:

void BasicTester::SetBrightless(unsigned char brightless)

{

if (brightless > 0x64)

return;

unsigned char cmd[6] = {0};

cmd[0] = 0x5A;

cmd[1] = 0xA5;
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cmd[2] = 0x03;

cmd[3] = 0x04;

cmd[4] = brightless;

unsigned char checksum = 0;

for (int i = 2; i < 5; i++)

checksum += cmd[i];

cmd[5] = checksum;

// set time to tps02

int fd = open(DWIN_TPS02_UART, O_RDWR|O_NONBLOCK|O_NOCTTY);

if (fd < 0)

return;

::write(fd, cmd, 6);

::close(fd);

}

3.8 Buzzer Switch

CMD=0x03, DATA=(0x00:OFF, 0xFF:ON), Byte5 is checksum.

5A A5 03 03 0×00 | 0×FF Checksum

Use command echo to test:

Buzzer on：echo -e -n "\x5A\xA5\x03\x03\xFF\x05" > /dev/ttyS1

Buzzer off：echo -e -n "\x5A\xA5\x03\x03\x00\x06" > /dev/ttyS1

C++ example：

void BasicTester::SetBeep(bool status)

{

int fd = ::open(DWIN_TPS02_UART, O_RDWR | O_NONBLOCK | O_NOCTTY);

if (fd < 0)

return;
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if (status) { // set beep on

const unsigned char cmdBeepOn[6] = {0x5A, 0xA5, 0x03, 0x03, 0xFF, 0x05};

::write(fd, cmdBeepOn, 6);

} else { // set beep off

const unsigned char cmdBeepOff[6] = {0x5A, 0xA5, 0x03, 0x03, 0x00, 0x06};

::write(fd, cmdBeepOff, 6);

}

::close(fd);

}
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4 Cross-Compilation of LVGL Project Files

4.1 Software Requirements

LVGL supported version: 9.1.0

Download path: https://github.com/lvgl/lvgl/releases/tag/v9.1.0

Reference for LVGL development guide: https://docs.lvgl.io/master/

Compilation environment: Ubuntu 14.04 and other versions. For the environment setup, please refer to

Chapter 2.

Refer to the DEMO and resources: LvglDemo,

toolchain: buildroot-T113-LVGL9_1_0-sdk-soft20241216.tar, lvgl_demo_source.

4.2 Hardware Introduction

Currently, only the capacitive touch screen models of the 36 series are supported.

4.3 Cross Compilation

4.3.1 Preparation before Compilation

Open the main.c in LvglDemo, search for "main(void)" and perform the initialization of the input device.

In this example, the 36 series is equipped with T113-S3, so select "t113".

https://github.com/lvgl/lvgl/releases/tag/v9.1.0
https://docs.lvgl.io/master/
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4.3.2 Compilation Steps

Copy the folder LvglDemo and the toolchain buildroot-T113-LVGL9_1_0-sdk-soft20241216.tar to

Ubuntu.

Open the Terminal and extract the SDK (toolchain) buildroot-T113-LVGL9_1_0-sdk-soft20241216.tar.

Enter：

tar -xvf buildroot-T113-LVGL9_1_0-sdk-soft20241216.tar
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After waiting for the extraction to complete, run the script→set the environment variables→open the

project file→execute make to obtain the executable file.

Source buildroot-T113-LVGL9_1_0-sdk-soft20241216/env-setup.sh

cd LvglDemo/

make

Obtain the executable file lvgl_demo, and the file path is LvglDemo/build/bin.

cd build/bin/

4.3.3 Run Tests

Copy the executable file lvgl_demo obtained from the compilation in the previous step and the

provided lvgl_demo_source to a USB flash drive, and then insert the USB flash drive into the USB interface

of the screen.
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Connect the screen to the computer via a network cable. For the specific operation steps, please refer to

Telnet Connection via Ethernet. Use the MobaXterm tool to copy the two files, namely "fonts" and "images",

from the USB flash drive to the /var/setting/lvgl directory.

cd /mnt/usb/sdaXXX/lvgl_demo_source (sdaXXX is the file location where the USB flash drive is mounted

on the screen. It can be obtained by entering cd /mnt/usb/ and then pressing the Tab key.)

cp -rf fonts/ /var/setting/lvgl/

cp -rf images/ /var/setting/lvgl/

Copy the executable file to the ~ directory via a USB flash drive, and then test and run the program.

cd /mnt/usb/sda1/ (sda1 can be obtained through the Tab key.)

cp lvgl_demo ~

cd ~

./lvgl_demo
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At this time, the DEMO has been installed on the screen.
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4.4 Precautions

4.4.1 Makefile

If you develop independently based on the DEMO, please modify the Makefile according to the specific

situation of your own project.

4.4.2 Third-Party Library

If you need to load a third-party library (such as freetype in the sample project), open the lvgl.mk file in

the lvgl directory and add the source code path, header files, etc.
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5 Revision Records

Rev Revise Date Content Editor

00 2022-10-11 First Edition Yu Yihe

01 2023-12-1 Update the boot startup logo Chen Yan

02 2024-3-20 Added examples about brightness adjustment,

system time settings and buzzer switch.

Chen Yan

03 2025-03-20

Add the configuration of cross-compilation

between Chapter 1 and Qt Creator.

Add the cross-compilation configuration for

LVGL.

Chen Xian

Please contact us if you have any questions about the use of this document or our products, or if you would like to know the

latest information about our products:

Customer service Tel: +86-400-018-9008

Customer service email: dwinhmi@dwin.com.cn

Website: www.dwin-global.com

DWIN Developer Forum: https://forums.dwin-global.com/index.php/forums

Thank you all for continuous support of DWIN, and your approval is the driving force of our progress!

mailto:dwinhmi@dwin.com.cn
http://www.dwin-global.com/
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